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 BÀI 3: HƯỚNG DẪN SỬ DỤNG PHẦN MỀM ENDNOTE TRONG QUẢN 
LÝ VÀ TRÍCH DẪN TÀI LIỆU THAM KHẢO 

MỤC TIÊU HỌC TẬP 
Sau khi kết thúc bài học, sinh viên có khả năng: 

1. Biết quản lý danh mục tài liệu tham khảo. 
2. Biết tạo danh mục tài liệu tham khảo. 
3. Áp dụng được phần mềm Endnote giúp tự động hóa việc trích dẫn và lập danh mục tài liệu 

tham khảo. 
 

NỘI DUNG HỌC TẬP 
1. Giới thiệu phần mềm EndNote 
Endnote là một trong các phần mềm quản lý tài liệu tham khảo được sử dụng phổ biến hiện 
nay.EndNote là phần mềm quản trị cơ sở dữ liệu có bản quyền của hãng Thomson Reuter giúp lưu 
trữ và quản lý tài liệu trích dẫn/tài liệu tham khảo. 
Hiện phiên bản mới nhất là phiên bản X6 được đưa ra thị trường vào tháng 11 năm 2012. Phiên bản 
X4 ra đời năm 2010. 
Phần mềm Endnote có 4 tiện ích chính: 

• Phần mềm Endnote là một công cụ tìm kiếm trực tuyến rất hữu ích. Với Endnote bạn có thể 
tìm kiếm thông tin từ các nguồn dữ liệu trên mạng Internet và đưa các tài liệu tham khảo về 
lưu trữ trong thư viện của Endnote một cách dễ dàng. Endnote cũng có thể giúp bạn xuất dữ 
liệu để lưu trữ tại các dịch vụ trực tuyến và các cơ sở dữ liệu. 

• Endnote là một kho dữ liệu tham khảo với các chức năng lưu trữ, quản lý, tìm kiếm tài liệu 
tham khảo cho thư viện tài liệu tham khảo của cá nhân người sử dụng. 

• Sử dụng phần mềm Endnote cho phép người sử dụng trích dẫn trực tiếp tài liệu tham khảo vào 
file word. 

• Endnote có thể giúp bạn tạo danh mục tài liệu tham khảo và bản thảo yêu cầu định dạng của 
nhà xuất bản. 

Phần hướng dẫn sau đây là dành cho phiên bản EndNote X4 dùng trong MS Word 2007. 

2. Cài đặt và khởi động Endnote 

Khi có bộ cài đặt Endnote bạn có thể cài đặt một cách dễ dàng. Bạn có thể cài đặt EndNote vào ổ 
C:\Program Files. Sau khi đã cài đặt xong, nhấn vào nút Start và tìm trong phần Program hoặc 
tạo icon trên desktop và chỉ cần click vào icon trên màn hình khi sử dụng.  
Ngoài ra bạn cũng có thể tải bản dùng thử miễn phí từ trang web của hãng Thomas Reuters với 
phiên bản mới nhất bằng cách truy cập website www.endnote.com: 

1. Vào trang web www.endnote.com 
2. Từ menu bên trái chọn “Download Trial” 
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3. Điền vào form và làm các bước theo hướng dẫn để cài đặt phần mềm EndNote. 
Lưu ý: 

• Bản dùng thử này có hiệu lực trong vòng 1 tháng, kể từ ngày đầu tiên bạn bắt đầu sử dụng 
chương trình. 

• Trong vòng 1 tháng dùng thử, tất cả mọi chức năng, công cụ của chương trình EndNote đều có 
thể sử dụng được. 

• Sau thời hạn 1 tháng dùng thử, chương trình sẽ tự động chuyển đổi thành phiên bản EndNote 
Viewer. 

• Các chức năng có thể sử dụng trong EndNote Viewer: 
- Mở các file EndNote; 
- Tìm kiếm, sắp xếp và in các tài liệu tham khảo. 

• Với EndNote Viewer, người sử dụng không thể: 
- Bổ sung hoặc chỉnh sửa các tài liệu tham khảo trong file đã có từ 10 tài liệu tham khảo trở 

lên; 
- Định dạng trên 10 tài liệu trích dẫn trở lên trong một bài viết; 
- Tìm kiếm trên 10 tài liệu tham khảo từ một cơ sở dữ liệu trực tuyến; 
- Nhập khẩu trên 10 tài liệu tham khảo; 
- Xuất khẩu trên 10 tài liệu tham khảo tại một thời điểm. 

3. Tạo một thư viện EndNote mới 

 
 
 
 
 
 
 
 
  

“Thư viện Endnote” là gì? 
Thuật ngữ “thư viện Endnote” dùng để chỉ một file dữ liệu mà bạn lưu trữ tất cả 
các dữ liệu về tài liệu tham khảo của mình. Một thư viện trong Endnote có thể lưu 
trữ đến 100,000 tài liệu tham khảo. 
Trên thực tế bạn có thể duy trì nhiều thư viện cùng một lúc tuy nhiên điều đó là 
không cần thiết, mà nên lưu trữ tất cả các tài liệu tham khảo vào một thư viện và 
tạo các nhóm tài liệu tham khảo theo chủ đề mà bạn quan tâm.  
Bạn có thể cài đặt một thư viện mặc định, thư viện này sẽ tự động mở ra mỗi khi 
bạn khởi động Endnote mà không phải qua hộp thoại giới thiệu nữa.    



Điều đầu tiên cần làm khi bắt đầu sử dụng EndNote là tạo một thư viện mới bao gồm các bước cụ 
thể: 

1. Khởi động chương trình EndNote. 
2. Một cửa sổ xuất hiện yêu cầu bạn Get started with EndNote X4. 

Trong lần sử dụng đầu tiên bạn sẽ thây trên màn hình xuất hiện hộp thoại: 
 

 
 

Hộp thoại này cho phép bạn tìm hiểu về Endnote, hoặc tạo một thư viện Endnote mới hoặc mở một 
thư viện Endnote đã tồn tại. 

3. Chọn nút “Create a new EndNote library”. 
4. Nhấn nút OK và màn hình sau đây sẽ xuất hiện:  
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5. Đặt tên file mới của bạn. 
6. Lưu vào thư mục C:\Program Files\EndNote X4\Examples hoặc vào bất cứ thư mục nào bạn 

muốn. 
7. Chọn Save. 

Một thư viện Endnote mới được mở ra, bây giờ bạn đã có một file mới để bắt đầu nhập dữ liệu: 
 

 
 

Tại cửa sổ này, ô ở góc phải dưới (Tab pane) cho phép bạn nhìn được định dạng tài liệu tham khảo 
của mình, đồng thời người sử dụng có thể tìm kiếm tài liệu tham khảo. Ô này có thể được đóng lại 
bằng cách click vào nút Hide Tab Pane.  
 
Ô My Library bên trái cho phép bạn nhóm các tài liệu tham khảo vào thành từng nhóm. Ô này cũng 
có thể đóng lại bằng cách click vào chức năng Groups trên thanh công cụ và chọn Hide Groups. 
Các file trong Endnote được đóng, mở như các file Word. Để đóng một file, nhấn vào nút File trên 
thanh công cụ và sau đó chọn Close Library hoặc bấm đồng thời phím Ctrl và W. 
 
Chú ý: Phần mềm EndNote sẽ đóng hoàn toàn khi chọn nút File trên thanh công cụ và nhấn vào nút 

Exit, hoặc khi nhấn vào nút  ở góc trên cùng bên phải màn hình. Tất cả các thay đổi, cập 
nhật gần nhất bạn đã thực hiện sẽ được lưu lại. 
Nếu bạn đã thoát khỏi chương trình, hãy mở EndNote và tìm file trong thư mục mà bạn đã lưu bằng 
cách chọn File > Open > Open Library… 
 

 



3.1. Nhập thông tin cho một tài liệu tham khảo mới 

Bao gồm các bước: 
Bước 1: Mở file đã có sẵn hoặc tạo file mới 
Bước 2: Chọn References > New Reference hoặc nhấn và giữ phím Ctrl + N. 
Bước 3: Một biểu mẫu (form) rỗng hiện ra để bạn nhập dữ liệu. 
 

 
 

Bước 4: Nhập các thông tin về tài liệu tham khảo: 
• Chọn kiểu tài liệu: Từ ô Referene Type, mở menu dọc. Từ đây bạn sẽ thấy danh sách các kiểu 

tài liệu khác nhau để bạn chọn. Mỗi kiểu tài liệu sẽ có một biểu mẫu với những thông tin phù 
hợp với từng dạng tài liệu 

 
Các dạng tài liệu: 
- Journal Article 
- Magazine  
- Newspaper Article 
- Book 
- Book section 
- Web Page  
- ….. 

• Nhập thông tin về các tài liệu trích dẫn 
- Tác giả (Author):Mỗi tác giả phải nhập vào một dòng riêng (nhập xong tác giả thứ nhất, 

nhấn phím Enter để xuống dòng nhập tiếp tác giả thứ hai). 
+ Với tên tác giả Âu-Mỹ, trật tự sử dụng là Tên Đệm Họ  
+ Với tên tác giả Việt Nam, trật tự nên sử dụng là Họ Đệm Tên. 
+ Ví dụ: Hoàng Thị Hải Vân 
+ Với tác giả Việt Nam có tên bắt đầu bằng chữ “Đ”, ví dụ: Nguyễn Văn Đông,  khi nhập 

vào ô tác giả trong EndNote nên nhập thêm chữ “z” sau chữ “Đ” để EndNote sắp xếp đúng 
theo thứ tự chữ cái tiếng Việt (chứ D xếp trước chữ Đ). Ví dụ: Nguyễn Văn Đzông. Sau khi 
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bài viết đã hoàn thành, có thể dùng công cụ “Find and Replace” của MS Word để thay 
thếcác chữ “Đz” bằng chữ “Đ”. 

 
 

+ Nếu tác giả là cơ quan, tổ chức thì phải đặt dấu phẩy ở cuối tên, ví dụ:  Viện Đào tạo Y học 
dự phòng và Y tế công cộng, 

 
 

Chú ý: tên tác giả sẽ có màu đỏ nếu đây là lần đầu tiên bạn nhập tên tác giả (cá nhân hoặc cơ quan, 
tổ chức) ngay vào file đang mở. Sau này nếu bạn có tài liệu tham khảo khác cũng có tác giả là cá 
nhân hoặc cơ quan tổ chức đã có tên trong file này thì EndNote sẽ tự động nhận ra và chỉ cần bạn 
đánh vài từ đầu tiên là những tên tương tự sẽ hiện ra để bạn lựa chọn mà không phải đánh lại tất cả 
các từ. 

- Year: năm xuất bản của tài liệu (hoặc dùng phím TAB trên bàn phím để chuyển đến ô tiếp 
theo). 



- Tiếp tục nhập thông tin vào các ô còn lại. Không cần thiết phải nhập số liệu vào tất cả các 
ô. Tuy nhiên nếu có nhiều thông tin thì sẽ tốt hơn. EndNote sẽ tự tạo các danh mục với các 
thông tin cần thiết cho từng kiểu trích dẫn mà bạn chọn. 

- Một số thông tin hứu ích khác nên nhập vào file EndNote: 
- Language: nên nhập thông tin vào ô này nếu bạn muốn danh mục tài liệu tham khảo được 

phân theo ngôn ngữ trước, sau đó mới sắp xếp theo thứ tự chữ cái tên tác giả. Cần thống 
nhất mã cho từng ngôn ngữ, ví dụ nhập vào ô “Language” chữ cái “v” cho tất cả các tài liệu 
bằng tiếng Việt, và dùng chữ cái “e” cho tất cả các tài liệu bằng tiếng Anh. 

- Label: (nhãn) sử dụng cho bất kỳ thông tin gì, ví dụ: tên của khóa học/môn học hoặc công 
trình nghiên cứu mà bạn đang thực hiện. Sau này bạn có thể tìm trong EndNote tất cả các 
tài liệu bạn đã đọc/tìm thấy cho khóa học/môn học… này. 

- Keywords: (từ khóa) các từ mô tả chủ đề của tài liêu. 
- Abstract: (tóm tắt) tóm tắt nội dung của tài liệu. 
- Notes: (ghi chú) dùng cho bất kỳ thông tin gì, ví dụ: nhận xét, đánh giá của bạn về tài liệu 

này, hoặc sao chép những thôgn tin mà bạn dự định trích dẫn. 
- URL: ô này có thể sử dụng để lưu đường dẫn đến các tài liệu trực tuyến hoặc một file trong 

máy tính của bạn. Để mở tài liệu ra, bạn chỉ việc nhấn vào đường dẫn đó, hoặc chọn 
References > Open Link, hoặc bấm đồng thời 2 phím Ctrl và G. 

- File Attachments: ô này có thể sử dụng để đính kèm những file liên quan. Để đính kèm 
file, nháy chuột phải vào ô File Attachments, chọn File Attachments >> Attach File… Có 
thể đính kèm nhiều file vào ô này và mở file trực tiếp từ đây: 
 

 
 

Bước 5: lưu tài liệu 
Tài liệu tham khảo của bạn sẽ được tự động lưu lại khi bạn đóng cửa sổ mà bạn đang nhập dữ 

liệu lại. Muốn đóng cửa sổ nhập dữ liệu của tài liệu tham khảo, nhấn vào nút  thứ 2 tính từ 
góc trên bên phải màn hình, hoặc nhấn đồng thời 2 phím Ctrl và F4. Nếu bạn tình cờ nhấn vào 
nút đầu tiên ở góc trên bên phải màn hình, chương trình EndNote sẽ đóng lại hoàn toàn và sẽ lưu 
lại toàn bộ những thay đổi bạn đã thực hiện gần nhất. 
Chú ý quan trọng: Sao lưu dữ liệu! 
Khi đã nhập dữ liệu vào file, đây là lúc bạn cần sao lưu dữ liệu đề phòng trường hợp có sự cố với 
ổ cứng máy tính bạn dùng. Nếu file của bạn không quá lớn (tối đa là 3000 tài liệu tham khảo), 
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bạn có thể dễ dàng lưu trữ vào USB hoặc đĩa mềm 1,44MB. Nên nhớ là bạn đã mất khá nhiều 
công sức để nhập dữ liệu. Dưới đây là cách sao lưu: 
Từ File, chọn Save a Copy. 
Chọn tên file mới, hoặc giữ nguyên tên cũ. Nếu bạn giữ nguyên tên file cũ, EndNote sẽ tự động 
thêm từ copy vào cuối tên file sao lưu. Ví dụ: kinhte copy.enl 
Soát lỗi chính tả (tiếng Anh) 
Khi bạn hoàn tất việc nhập dữ liệu cho một tài liệu, bạn có thể soát lỗi chính tả (chỉ dành cho 
tiếng Anh). Chỉ có thể soát lỗi chính tả cho từng tài liệu, khi bạn đang mở màn hình về tài liệu 
đó. Có 3 cách kích hoạt chức năng soát lỗi chính tả: 
• Từ Tools, chọn Spell Check 
• Hoặc nhấn đồng thời 2 phím Ctrl và Y 
• Hoặc nhấn vào biểu tượng  trên thanh công cụ. 
Xem trước kiểu trích dẫn 
Nhấn vào nút Preview, bạn sẽ xem trước được cách hiển thị của tài liệu trong danh mục tài liệu 
trích dẫn/tài liệu tham khảo theo kiểu trích dẫn hiện đang được chọn. 
 

 
 

3.2. Nhập tài liệu tham khảo từ file tài liệu đã có trong máy 

Đôi khi thư viện Endnote được tạo khi đã trong máy bạn đã có các tài liệu được download về từ 
trước đó hoặc muốn chuyển một tài liệu tham khảo từ thư viện Endnote khác đã tạo trong máy. Khi 
đó để đưa tài liệu vào thư viện Endnote bạn không cần phải nhập các thông tin chi tiết cho tài liệu 
tham khảo này như các bước đã làm ở trên (với điều kiện tên file chính là tên chính xác của tài 
liệu/bài báo đã được đăng tải trên tạp chí và ở dưới dạng pdf  hay nói cách khác bài báo có pdf có 
DOI – Digital Object Identifier: số chứng minh cho một tập tin Word Wide Web). 
Cách làm:  

1. Trên thanh menu của Endnote, chọn biểu tượng Import hoặc vào File >chọn Import 
>File  

2. Click choose và chọn đường dẫn của file  



3. Chọn định dạng pdf >chọn import all (nhập toàn bộ) hoặc discard duplicate (loại bỏ file 
trùng nhau)  

4. Cuối cùng chọn import.  
Nếu thành công, các thông tin về file dữ liệu như tên tác giả, năm xuất bản, tên bài báo, tên tạp chis 
và file attach sẽ được cập nhật vào thư viện Endnote của bạn. 

3.3. Tìm kiếm tài liệu từ các cơ sở dữ liệu bằng phần mềm Endnote 

Chúng ta có thể tìm kiếm một số cơ sở dữ liệu trực tiếp từ Endnote 
1. Máy tính của bạn phải kết nối với Internet và phần mềm Endnote đang ở trạng thái hoạt động 
2. Các cơ sở dữ liệu sẵn có xuất hiện ở thanh công cụ bên trái của nàm hình bên dưới menu 

Online Search 
3. Chọn cơ sở dữ liệu bằng cách click trực tiếp vào cơ sở dữ liệu xuất hiện dưới menu online 

search hoặc click vào more để chọn cơ sở dữ liệu, khi đó cửa sổ tìm kiếm sẽ mở ra ở góc phải 
dưới của màn hình. 

4. Đánh từ khóa và click Search và ok 
 

 
 

5. Tuy nhiên phưong pháp tìm kiếm này bị hạn chế khi tìm kiếm do bạn không thể giới hạn chỉ 
tìm các bản toàn văn hoặc các bản có quá trình xét duyệt trước khi đăng tải (peer review) 

3.4. Tìm kiếm tài liệu online và tải về thư viện Endnote (Xuất trực tiếp tài liệu tham khảo 
từ cơ sở dữ liệu) 

Cách này cho phép bạn tải trực tiếp các thông tin từ cơ sở dữ liệu về thư viện Endnote của bạn. Cách 
này có thể áp dụng rộng rãi với rất nhiều cơ sở dữ liệu và đòi hỏi bạn phải kết nối Internet và chạy 
chương trình Endnote trong khi tải tài liệu về thư viện. 
Hiện có rất nhiều trang web cung cấp kiến thức và cơ sở dữ liệu như Eric, EBSCO, Informit, 
OVIDSP, Proquest, Sciendirect, Scopus, JSTOR và nhiều cơ sở dữ liệu khác cho phép xuất trực tiếp 
và tải tài liệu về thư viện Endnote mà không cần phải tải file dữ liệu về trước. 

1. Khởi động Endnote 
2. Kết nối Internet, truy cập vào website của cơ sở dữ liệu mà bạn muốn 
3. Search (tìm kiếm) tài liệu trên cơ sở dữ liệu mà bạn lựa chọn 
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4. Làm theo hướng dẫn của quy trình xuất tài liệu tham khảo của cơ sở dữ liệu. 
Dưới đây là một số ví dụ xuất tài liệu tham khảo từ một số cơ sở dữ liệu về thư viện Endnote. 

3.4.1. Ví dụ 1: Xuất tài liệu tham khảo từ website JSTOR: 

1. Truy cập hoặc chọn JSTOR từ danh sách các cơ sở dữ liệu hoặc truy cập trực tiếp vào website 
jstor.org.  

2. Đánh từ khóa và tìm kiếm hoặc dùng advanced search 
3. Đánh dấu tài liệu định tải về thư viện Endnote và chọn Export 

 

 
 

4. Trong cửa sổ Export Ciation chọn RIS file  
 

 
 

5. Click mở file citation.ris xuất hiện ở góc bên trái dưới của màn hình 
6. Các tài liệu được chọn sẽ tự động xuất vào thư viện Endnote đang mở sẵn 



7. Trong Endnote, các tài liệu tham khảo sẽ được hiển thị trong Imported References. Chọn All 
references để xem toàn bộ thư viện 

3.4.2. Ví dụ 2: Xuất tài liệu từ website Sciendirect: 

1. Truy cập website ScienceDirect và đánh từ khóa để tìm kiếm tài liệu 
2. Đánh dấu vào ô lựa chọn bên trái của mỗi tài liệu mà bạn lựa chọn 
3. Click nút Export Citation trên đầu trang của danh mục tài liệu đã tìm kiếm được 

 

 
 

4. Trong Content Format chọn Citation Only hoặc Citations and Abstract  
5. Trong Export Format chọn RIS format 

  

 
 

6. Click Export  
7. Các tài liệu được lựa chọn sẽ được xuất trực tiếp vào thư viện Endnote của bạn hoặc bạn sẽ 

được hỏi lựa chọn thư viện cất giữ tài liệu, sau đó click open. 
8. Trong Endnote, các tài liệu tham khảo sẽ được hiển thị trong Imported References. Chọn All 

references để xem toàn bộ thư viện 

3.4.3. Ví dụ 3: Xuất tài liệu tham khảo từ Eric.ed.gov: 

1. Truy cập website Eric.ed.gov, đánh từ khóa để tìm kiếm tài liệu 
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2. Chọn tài liệu tải về bằng cách click vào nút add bên góc phải của tài liệu để chuyển sang 
added. 
 

 
 

3. Ở góc bên phải của kết quả tìm kiếm hiện số tài liệu mà bạn đã lựa chọn, click vào đó, một 
bảng thống kê các thông tin về các tài liệu mà bạn đã lựa chọn sẽ hiện ra 

 
 

 
 

4. Chọn Export citations 
5. Chọn Citation manager file 
6. Click Dowload 
7. Click vào file citations.ris xuất hiện ở góc trái dưới màn hình 
8. Các tài liệu được chọn sẽ tự động xuất vào thư viện Endnote đang mở sẵn 
9. Trong Endnote, các tài liệu tham khảo sẽ được hiển thị trong Imported References. Chọn All 

references để xem toàn bộ thư viện 
 



 
 

4. Ứng dụng Endnote trích dẫn tài liệu tham khảo trong Word 

4.1. Trích dẫn trong khi viết (MS Word 2010) 

Mở một file Word sẵn có. Nút tab của EndNote (xem hình dưới đây) xuất hiện trong file Word sau 
khi máy tính của bạn đã được cài chương trình EndNote. 
 

 
 
Chức năng định dạng tức thời của EndNote cho phép tự động hiển thị tài liệu trích dẫn và tạo danh 
mục tài liệu trích dẫn ngay khi bạn chèn một trích dẫn vào văn bản Word. 
Chèn một trích dẫn mới 

1. Để con trở vào nơi bạn muốn chèn thông tin về tài liệu trích dẫn. 
2. Quay trở lại chương trình EndNote, hoặc bạn có thể nhấn vào nút  tại thanh công 

cụ EndNote. 
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3. Từ file EndNote, tìm tài liệu mà bạn muốn chèn thông tin trích dẫn và nhấn chuột vào tài liệu 
đó (không cần mở ra). 

4. Để chọn cùng lúc nhiều tài liệu trích dẫn, nhấn và giữ phím Ctrl, đồng thời nhấn chuột vào 
những tài liệu cần chọn để trích dẫn. 

5. Quay lại văn bản Word và nhấn vào nút Insert Citation hoặc Insert Selected Citation(s) ở 
thanh công cụ EndNote. Thông tin về tài liệu trích dẫn sẽ xuất hiện trong đoạn văn cũng như 
trong danh mục tài liệu trích dẫn/tài liệu tham khảo ở cuối tài liệu. 

 

 
 

Các phần mềm soạn thảo văn bản khác cũng có thể tích hợp EndNote, tuy nhiên cách thao tác sẽ 
khác nhau. EndNote làm việc tốt nhất trong hai phần mềm MS Word và WordPerfect.  
 

4.1.1. Định dạng một danh mục tài liệu tham khảo 

Các hệ thống trích dẫn phổ biến trên thế giới được cài đặt mặc định trong Endnote trừ quy định trích 
dẫn của Bộ Giáo dục và Đào tạo, tuy nhiên bạn có thể bổ sung hệ thống trích dẫn của Bộ Giáo dục 
và Đào tạo bằng cách đưa một số file quy định định dạng của Bộ GD&ĐT vào thư mục stye của 
Endnote. Bạn có thể lựa chọn định dạng kiểu trích dẫn mà bạn muốn. 
Có hai cách lựa chọn định dạng trong Endnote: 

• Cách 1: Từ thanh công cụ chọn Edit, chọn Output Style và lựa chọn hệ thống mà bạn muốn 
 



 
 
Nếu trong danh mục không có hệ thống trích dẫn bạn muốn có thể click vào Open Style Manager 
để lựa chọn. 

• Cách 2: Trên thanh công cụ EndNote, nhấn vào nút Style, lựa chọn hệ thống trích dẫn bạn 
mong muốn, nếu không có trong danh mục chọn Select Another Style, khi đó một danh mục 
mới với đầy đủ các hệ thống trích dẫn sẽ được mở ra và bạn có thể lựa chọn hệ thống mong 
muốn.  

 
 
Sửa trích dẫn trong văn bản 
Để sửa trích dẫn trong văn bản, nhấn chuột vào thông tin về tài liệu trích dẫn mà bạn vừa mới chèn 
vào văn bản. Thông tin về tài liệu trích dẫn sẽ được đánh dấu bằng nền màu nâu. 
Chọn Edit & Manage Citation(s) trên thanh cộng cụ EndNote trong Word . 
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Hộp thoại trên cho phép người sử dụng có thể chỉnh sửa thông tin về tài liệu trích dẫn. Ví dụ: nếu 
bạn đã sử dụng tên tác giả trong câu văn và không muốn nó xuất hiện nữa, bạn có thể nhấn vào ô 
Exclude author, thực hiện tương tự đối với thông tin về năm xuất bản của tài liệu trích dẫn. Số 
trang của thông tin được trích dẫn cũng có thể được bổ sung vào ô Pages. 
Các tùy chọn khác cũng có thể thay đổi, ví dụ như thêm từ vào đầu hoặc cuối thông tin về tài liệu 
trích dẫn. 
Bạn cũng có thể xóa một tài liệu trích dẫn, chèn một tài liệu trích dẫn hoặc chỉnh sửa, cập nhật thông 
tin về tài liệu tham khảo trong thư viện Endnote bằng cách chọn Edit Reference và click vào lệnh 
tương ứng. 

 
 

Khi đã hoàn thành việc chỉnh sửa, nhấn vào nút OK, và những thay đổi bạn đã thực hiện sẽ được áp 
dụng. 



4.1.2. Chỉnh sửa các loại tài liệu 

Các kiểu trích dẫn – mẫu cho sẵn 
Ở Bước 2, chúng tôi đã giới thiệu cách chọn một kiểu tài liệu phù hợp với tài liệu bạn đang nhập vào 
file EndNote. Mỗi loại tài liệu cần nhập các thông tin khác nhau đặc trưng cho từng loại tài liệu. Ví 
dụ: đối với một bài báo cần các thông tin về tên tài báo, tác giả, tên tờ báo (tạp chí), quyển số mấy, 
tập mấy, năm xuất bản và số trang. Một cuốn sách lại cần những thông tin khác với bài báo như: tên 
cuốn sách, tác giả, nhà xuất bản, nơi xuất bản (tên thành phố) và năm xuất bản. Khi mở một cửa sổ 
nhập liệu mới, mẫu cho sẵn sẽ cung cấp các ô mà bạn cần nhập thông tin cần thiết về tài liệu tham 
khảo. 
Chỉnh sửa và cá nhân hóa các loại tài liệu 
Nếu bạn muốn bổ sung thông tin vào một mẫu cho sẵn, ví dụ: muốn thêm một ô nhập liệu, hoặc bạn 
muốn bỏ bớt đi một số ô, quy trình tiến hành như sau: 
Từ màn hình EndNote, chọn Edit > Preferences > Reference Types > Modify Reference Types 
Chọn từ menu dọc loại tài liệu mà bạn muốn sửa đổi thông tin trích dẫn. Loại ngầm định là Journal 
Article (bài báo chuyên ngành). Bạn có thể thay đổi thông tin ở cột bên phải. 
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Sử dụng thanh trượt dọc để xem/sửa các ô. 

4.2. Sửa đổi các kiểu danh mục tài liệu tham khảo 

Chỉnh sửa kiểu trích dẫn hiện có 
Trong trường hợp kiểu trích dẫn có trong EndNote có thể khác đôi chút với kiểu trích dẫn mà bạn 
muốn hoặc theo yêu cầu của tạp chí đăng bài. Khi đó, bạn cần phải chỉnh sửa kiểu trích dẫn để cho 
thông tin trích dẫn trong văn bản của bạn được định dạng phù hợp với yêu cầu. 
Trước hết, kiểm tra thông tin ở thanh công cụ EndNote về kiểu trích dẫn đang chọn. 
- Nếu đây không phải là kiểu bạn cần chỉnh sửa, nhấn chuột vào menu  dọc và chọn Select Another 
Style để chọn một kiểu từ trong danh sách.  
- Để chỉnh sửa kiểu trích dẫn này, chọn  Edit > Output Styles > và Edit Havard (hoặc bất cứ kiểu 
trích dẫn nào mà bạn muốn chỉnh sửa). 
- Từ menu bên trái màn hình chọn Citations để xem cách hiển thị của thông tin về tài liệu trích dẫn 
trong đoạn văn cũng như trong danh mục tài liệu tham khảo. 
- Chọn Citations > Templates để xem các thông tin cho sẵn đối với trích dẫn tại đoạn văn.  
- Chọn Bibliography > Templates để xem thông tin được hiển thị trong danh mục tài liệu tham 
khảo. 
 

 
 
Để thay đổi định dạng thông tin về tài liệu trích dẫn, bôi đen từ/cụm từ mà bạn muốn sửa. Sử dụng 
các nút trên thanh công cụ và menu giống như cách bạn làm trong Word. 
Ngoài ra các thông tin và dấu câu sử dụng trong một trường cụ thể nào đó cũng có thể thay đổi.  
 
Trích dẫn và trình bày danh mục tài liệu tham khảo theo quy định của Bộ Giáo dục – Đào tạo 
Nếu bạn muốn sử dụng kiểu trích dẫn đánh số thứ tự theo quy định của Bộ Giáo dục Đào tạo, Trong 
thư mục Style của thư mục cài đặt phần mềm EndNote cần có 3 file: BGDDT-TA.ens; BGDDT-
TV.ens; và BGDDT-TV-TenVN.ens. 



Đây chính là 3 kiểu định dạng trích dẫn theo quy định của Bộ Giáo dục Đào tạo với các đặc điểm 
chính như sau: 

• BGDDT-TA: Trích dẫn kiểu đánh số theo quy định của Bộ Giáo dục Đào tạo, tên tác giả hiển 
thị theo kiểu tên người phương Tây (theo trật tự Họ, Tên Đệm, ví dụ Douglas, Altman hay 
Hoạt, Lưu Ngọc). Các yếu tố khác hiển thị bằng tiếng Anh, ví dụ: and others, in editors, p. 

• BGDDT-TV: Trích dẫn kiểu đánh số theo quy định của Bộ Giáo dục Đào tạo, tên tác giả hiển 
thị theo kiểu tên người phương Tây (theo trật tự Họ, Tên Đệm, ví dụ Douglas, Altman hay 
Hoạt, Lưu Ngọc). Các yếu tố khác hiển thị bằng tiếng Việt, ví dụ: và các cộng sự, trong, chủ 
biên, tr. 

• BGDDT-TV-TenVN: Trích dẫn kiểu đánh số theo quy định của Bộ Giáo dục Đào tạo, tên tác 
giả hiển thị theo kiểu tên người Việt Nam (theo trật tự Họ Đệm Tên, ví dụ Douglas Altman 
hay Lưu Ngọc Hoạt). Các yếu tố khác hiển thị bằng tiếng Việt, ví dụ: và các cộng sự, trong, 
chủ biên, tr. 

Trật tự sắp xếp danh mục tài liệu tham khảo của cả 3 kiểu trích dẫn này là: 
1. Sắp xếp theo ngôn ngữ: tài liệu tiếng Việt trước, tiếng Anh sau, 
2. Sắp xếp theo vần chữ cái tên của tác giả (tác giả Việt Nam) hoặc họ của tác giả (tác giả nước 
ngoài). 
3. Yếu tố sắp xếp tiếp theo là năm xuất bản và tên tài liệu. 

 
Cách tạo danh mục theo quy định của Bộ Giáo dục Đào tạo: 
Trong EndNote, để tạo ra được một danh mục tài liệu trích dẫn theo quy định của Bộ Giáo dục Đào 
tạo với hai phần tài liệu Tiếng Việt và Tài liệu Tiếng Ạnh tách rời nhau trong danh mục tài liệu tham 
khảo tiến hành như sau:  

1. Tạo ra 2 file word khác nhau hiển thị theo 2 kiểu: BGDDT-TV-TenVN và BGDDT-TA. 
2. Copy phần danh mục tài liệu tiếng Việt hoặc tiếng Anh theo đúng yêu cầu hiển thị cho từng 
loại ngôn ngữ vào file word cuối cùng. 
 

Chỉnh sửa cách trình bày danh mục tài liệu tham khảo – sắp xếp theo ngôn ngữ 
Quy định cũ của Bộ Giáo dục Đào tạo Việt Nam đối với luận án tiến sĩ là: danh mục tài liệu tham 
khảo phải được phân theo ngôn ngữ trước, sau đó mới sắp xếp theo vần chữ cái tên tác giả. Cách 
thực hiện yêu cầu này trong EndNote như sau: 

1. Khi nhập thông tin về tài liệu cần phải nhập mã ngôn ngữ vào ô “Language”.  
2. Tại cửa sổ chương trình EndNote, trong mục “Bibliographic Output Style”, chọn kiểu 
“Numbered”.  
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4. Vào mục Edit>chọn Output Styles>chọn Edit Numbered 
 

 
 

4. Ở phần Bibliography, chọnSort Order, tiếp đó chọn Other… 

 



5. Ở cửa sổ “Sort Options”: 

Ở ô thứ nhất, chọn “Language”, sau đó nhấn vào nút “A  Z” để sắp xếp theo mã ngôn ngữ. 
Ở các ô tiếp theo, chọn lần lượt là “Author”, “Year”, và “Title”. 
Nhấn nút “OK” để lưu lại cách sắp xếp này. 

 

5. Quản lý file EndNote (sắp xếp, tìm kiếm và tạo các nhóm tài liệu) 

5.1. Tìm kiếm các tài liệu trích dẫn trong file và sắp xếp 

Khi bạn mở một file EndNote, bạn sẽ có thể nhìn thấy 3 trường sau đây: 
Author (họ của tác giả đầu tiên) 
Year (năm xuất bản) 
Title (nhan đề) 
Thông thường các tài liệu tham khảo được sắp xếp theo vần chữ cái của tên tác giả. 
Nếu muốn thay đổi tiêu chí sắp xếp của các tài liệu tham khảo, bạn chỉ cần nhấn vào những ô 
Author, Year hoặc Title. Nhần vào ô này lần thứ 2, bạn sẽ thay đổi trật tự sắp xếp tăng dần hoặc 
giảm dần. Chức năng này rất hữu ích. Ví dụ: nếu bạn muốn sắp xếp các tài liệu tham khảo theo trình 
tự năm xuất bản từ tài liệu cũ nhất đến tài liệu mới nhất. 
Bạn cũng có thể sắp xếp theo các tiêu chí khác nhau bằng cách sử dụng nút sắp xếp  trên thanh 
công cụ chính. 
Nếu chọn Edit >> Preferences >> Display fields, bạn có thể thay đổi cách EndNote hiển thị và sắp 
xếp các tài liệu tham khảo trên màn hình chính. 
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Ví dụ: chọn Reference Type từ menu của cột 5, các tài liệu tham khảo sẽ được hiển thị theo loại 
hình tài liệu (ví dụ: bài báo, sách, v.v..) chứ không phải là sắp xếp theo URL. 
Nhấn nút EndNote Defaults >> OK, bạn sẽ thay đổi cách hiển thị về dạng ngầm định ban đầu. 

5.2. Tạo các nhóm (Groups) 

Chức năng Groups cho phép người sử dụng có thể tổ chức các tài liệu tham khảo của mình thành các 
nhóm nhỏ mà không cần tạo một file riêng biệt. Ô Groups hiển thị ở cột bên trái, nếu không thì có 
thể nhấn vào biểu tượng Show/Hide Groups hoặc vào menu Tools >> Show Groups. Có thể đổi 
tên của nhóm hoặc là xóa nhóm, hoặc là xóa các biểu ghi trong một nhóm, tuy nhiên thông tin gốc 
về các tài liệu trong file thư viện của bạn vẫn được giữ nguyên. Mỗi reference (thông tin về một tài 
liệu có thể được đưa vào nhiều nhóm khác nhau). 
Bổ sung một nhóm 
Từ menu References  chọn Groups và Create New Group, hoặc có thể nhấn chuột phải vào ô 
Groups và chọn Create New Group. Một nhóm mới sẽ hiện ra trong cột Groups và bạn có thể đặt 
tên nhóm tùy ý, ví dụ Bai tap 1. 
Bổ sung thông tin về tài liệu tham khảo vào nhóm 
Chọn tài liệu cần thiết, vào menu Referencesvà chọn Add Reference To sau đó chọn nhóm phù 
hợp, hoặc nhấn chuột phải vào tài liệu cần chọn và chọn Add Reference To sau đó chọn nhóm phù 
hợp. Để xem các tài liệu đã có trong một nhóm, chỉ cần nhấn chuột vào tên nhóm đó. 



6. Sử dụng mẫu bản thảo của EndNote trong Word 

6.1. Mẫu bản thảo (Manuscript Template) 

Nếu bạn đang viết luận văn hoặc viết một bài báo cho một tạp chí chuyên ngành, những mẫu bài viết 
này có thể có ích cho bạn vì chúng cung cấp hướng dẫn làm cho quá trình viết của bạn được dễ dàng 
hơn. EndNote có các mẫu bài viết cho một số khá lớn các tờ báo và các mẫu luận văn như MLA hay 
APA. Chúng được mở ra trong chương trình Word. 
Để mở một mẫu bản thảo từ Tools, chọn Manuscript Templates. Trong thư mục templates trong 
EndNote, chọn tên của tạp chí mà bạn cần rồi nhấn Open. Mẫu bài viết sẽ xuất hiện để bạn nhập văn 
bản. 

6.2. Bỏ các mã trường EndNote trong file văn bản đã hoàn thiện 

Nếu bạn đã hoàn thành bài viết, bạn muốn xóa các kết nối trong văn bản của mình tới file EndNote, 
qua đó cho phép những máy tính không cài EndNote cũng có thể đọc được file văn bản của bạn. Để 
làm việc này, bạn mở văn bản Word và nhấn vào nút Convert Citations and Bibliography > 
Convert to Plain Text  trên thanh công cụ EndNote trong file Word. 
 

 
 

Một bản sao khác của file văn bản, không có mã trường của EndNote sẽ hiện ra trong một cửa sổ 
mới. Hãy lưu văn bản này lại bằng một tên file khác. Lưu ý là bạn không thể định dạng lại các tài 
liệu tham khảo trong file mới này, mà chỉ có thể định dạng lại trong file gốc. 

7. Tìm kiếm trợ giúp trong EndNote 

7.1. Tìm kiếm trợ giúp trong EndNote 

Có thể xem hướng dẫn sử dụng endnote bằng cách chọn mục hướng dẫn sử dụng khi khởi động 
chương trình Endnote 
Start > Programs > Endnote > Getting Started Guide 

7.2. Truy cập website Endnote 

http://www.Endnote.com 
Thư mục Support and Service có thể giúp bạn: 

• Tìm hiểu về phiên bản mới nhất  
• Tìm kiếm hỗ trợ ký thuật qua email 
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• Hướng dẫn cách sử dụng các chức năng cơ bản của Endnote 
• Các liên kết với các thư viện, các tổ chức. 

 


